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1.0 — Introduction

pDoc Signer allows signing of PDF documents in a legally binding and secure manner. One
can embed handwritten signatures into PDF documents using this application. The application
allows one to visualize, fill and sign electronic documents, and create electronic signatures
using your handwritten signature. pDoc Signer also allows creation and filling of form fields. In
addition to digital signatures and form fields, pDoc Signer provides many other features to
manipulate the PDF. The remainder of the document describes the feature set and usage of
the pDoc Signer application. Handwritten signatures in pDoc Signer application are captured
using Topaz Signature Capture devices. See www.topazsystems.com.

pDoc Signer captures the handwritten “biometric” signature. The captured signature is shown
in the corresponding signature field in the document and can be viewed and verified in pDoc
Signer, or by other PDF document rendering applications like Adobe Acrobat or Reader.

pDoc Signer product has two main applications: pDoc Forms Designer and pDoc Signer.

1.1 — pDoc Forms Designer

The pDoc Forms Designer application is intended for people who are designing forms using
PDF documents. It is a graphical form design tool that simplifies the creation of form designs
for distribution as PDFs. Form recipients can fill, sign, print and save the filled-in form onto the
disk.

Using pDoc Forms Designer, form authors can drag-and-drop form fields such as Text Boxes,
Check Boxes, Radio Buttons, List Boxes, Combo Boxes and Electronic Signature fields.

pDoc Forms Designer also allows the designer to move and resize fields as required.
Optionally the forms designer can use features like adding attachments to attach any other
relevant documents to the PDF being designed.

After the PDF form is designed, the form can be secured if required using the Secure
Document feature of the pDoc Forms Designer.

1.2 — pDoc Signer

pDoc Signer is the application designed for the end-users who fill-in and sign the form. In
addition to filling-in and signing, pDoc Signer also provides features like adding comments,
pencil markups, and attachments. If required, you can also insert additional signatures using
the Insert & Sign feature.

4 www.topazsystems.com
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After the form is filled in and signed, the form can be secured if required using the Secure
Document feature of the pDoc Signer.

The remainder of this document explains the features of the pDoc Signer application in detail.

2.0 — Installing/Uninstalling pDoc Signer
2.1 — Before You Begin

e pDoc Signer runs on Windows operating systems beginning with Windows 2000.

e Your system should have a minimum of 30 MB free space on the hard drive, in addition
to the free space requirements for Windows.

e Before installing a new version of pDoc Signer, uninstall any older versions of pDoc
Signer on your machine.

2.2 — Installing the Signature Capture Device

pDoc Signer uses the signature pad software drivers that provide communication between
your PC and the signature pad, so the drivers must be installed on your PC before you can
capture signatures with pDoc Signer. If you have not installed the signature capture device,
refer to the manual provided by the signature capture device manufacturer for installation
instructions. Test the operation of the signature pad to insure that your PC can communicate
with it properly.

2.3 — Installing pDoc Signer

Installing pDoc Signer software is accomplished by running the pDoc Signer installation file
provided. During the installation one will be provided with an option to agree or disagree to the
license agreement, prompted to enter user information, and optionally set a different folder for
installation. The sequence of screens displayed guide the user through the installation
process.

During installation of pDoc Signer, an option screen with a check box for installing pDoc Forms
Designer will be provided. If the user checks the pDoc Forms Designer option, the pDoc Forms
Designer will be installed in the PC.

After installing pDoc Signer:

e One can access the pDoc Signer application using “Start - Programs >pDoc Signer
—->pDoc Signer”.

e One can access the pDoc Forms Designer application using “Start - Programs >
pDoc Signer »>pDoc Forms Designer”.

5 www.topazsystems.com
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2.4 — Uninstalling pDoc Signer
To uninstall pDoc Signer:
e (o to Start-> Settings - Control Panel ->Add/Remove programs.

e Select pDoc Signer and click on the “Remove” button. Follow the instructions to
uninstall the software.

Signatures that have been placed into documents are not removed during un-installation.

Note: Deleting the pDoc Signer installation folder directly will not uninstall the software
completely.

2.5 — Silent Installation of pDoc Signer
See the appendix for details on silent installation of pDoc Signer.

3.0 — Features of pDoc Signer
3.1 — Basic Operations and PDF File Manipulation
3.1.1 — Opening PDF Documents

PDF documents can be opened in pDoc Signer in two ways: either by using the
“File >Open” menu option or by using the “Open File” icon in the toolbar.

When you click on one of the two options above, you will be prompted to select the PDF
document to be opened. If another PDF document is already opened and there are changes to
be saved, pDoc Signer displays a message saying that “Only one document may be open at a
time. Do you want to save changes to the previously opened document?” Click on “Yes” or
“No” to proceed further and select a new document to open.

Once the file is selected, the first page of the PDF file is displayed in pDoc Signer.

If the PDF document that is being opened is secured document, refer to section 3.8.1 for
further explanation.

One can also select a PDF from the list of recently opened file list. Refer to section 3.12 for
more information.

6 www.topazsystems.com
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3.1.2 — Saving PDF Documents

The PDF document opened in pDoc Signer can be saved in two ways: either by using the “File
—>Save” menu option or by using the “Save File” icon in the toolbar. The “Save” option is
enabled only when there are changes that are not yet saved.

You can use the “File > Save As” menu option to save the document to a new file.

Also, pDoc Signer prompts you to save the file (if there are any changes that are not yet
saved) when you try to open another PDF document while this document is still open or when
exiting the pDoc Signer application.

3.1.3 — Page Navigation and Zooming

One can use the page navigation buttons available on the pDoc Signer toolbar to navigate
between pages. Alternatively, one can select the page number in the Page Number list to
navigate directly to the selected page.

If you are using a Windows Tablet and a licensed version of pDoc Signer, you can use the
tablet touch movements to navigate between pages. If you swipe to the left, you will be
navigated to the next page. If you swipe to the right, you will be navigated to the previous

page.

To move with in a page, you can use the scroll bar available on the right side of the pDoc
Signer UI.

If you are using a Windows Tablet and a licensed version of pDoc Signer, you can use the
tablet touch movements to move within a page. If you swipe up, the page will move up, and if
you swipe down, the page will move down.

To zoom in or zoom out, use the zoom buttons available in the toolbar. Every click of the zoom
button will increase or decrease the percentage by 25%. Alternatively, you can select the zoom
percentage in the available list. The maximum allowed zoom percentage is 200% and the
minimum is 25%.

If you are using a Windows Tablet and a licensed version of pDoc Signer, you can use the
tablet touch movements to zoom in or zoom out. If you "pinch" your fingers towards each other
while keeping contact with the screen, the page will be zoomed out by 25%. If you move your
fingers away from each other, the page will be zoomed in by 25%.

3.1.4 — Switching Screens

If you are using a licensed version of pDoc Signer, to support system configurations that use a
Pen Display for signing a document (perhaps by someone other than the PC user), there is a
new function called screen switching that enables the PC user to move the pDoc Signer Ul
window from the main PC monitor to the Pen Display. This can be accomplished by clicking on

7 www.topazsystems.com
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the “Switch Screens” menu in the pDoc Signer Ul. This menu item is available only if a Pen
Display is connected to the PC. See the screenshot below for reference.

[/ Introducing pDoc Signer.pdf - pDac Signer - _

File Tools About  Switch Screens

_H|/ BT 44 P P vﬂf9|é;} P 100% -
e
TOPAZ

SYSTEMS INC.

RSIZE !

When this button is clicked, the pDoc Signer Ul is moved to the Pen Display and on the main
PC monitor, you will see a window that has a button named “Recall pDoc Signer”. This button
can be used to move the pDoc Signer Ul window back to the main PC monitor anytime by the
PC user. See the screenshot below for reference.

pDoc Signer

I Recall pDoc Signer I

When the pDoc Signer Ul is moved to the Pen Display for obtaining signatures, the following
features of the Ul are grayed out and become inoperable.

a. File
b. Tools
C. About

d. The Openicon

e. The Save icon

8 www.topazsystems.com



SYSTEMS INC,
3.1.5 - Closing PDF Documents

The PDF document that is currently opened in pDoc Signer can be closed using the “File
—>Close” menu option. If there are any changes that are not yet saved, pDoc Signer prompts
you to do so before closing.

3.1.6 — Exiting pDoc Signer

To exit completely from pDoc Signer, chose “File > Exit” menu option or the Red “X” button on
the top right corner of the pDoc Signer application. If there are any unsaved changes in the
currently opened PDF document, pDoc Signer prompts you to do so before exiting.

3.1.7 — About

The “About” menu in pDoc Signer application contains three menu items: “About pDoc Signer”,
“What's New”, and “Introducing pDoc Signer”.

“About pDoc Signer” provides info about the installed version of pDoc Signer. Clicking on the
“What's New” menu item displays the “What’s New in pDoc Signer” PDF document in another
instance of pDoc Signer. Clicking on the “Introducing pDoc Signer” menu item displays the
Introducing pDoc Signer PDF document in another instance of pDoc Signer. This document
provides an introductory tutorial on pDoc Signer.

3.2 —Filling in Form Fields

When a PDF containing form fields is opened in pDoc Signer, pDoc Signer displays the form
fields that are available for filling at appropriate locations. The form fields that are supported
are Electronic Signature Box, Text Box, Radio Button, Check Box, and List and Combo Boxes.
Any other types of form fields present in the PDF are not displayed in pDoc Signer.

One can fill values in the displayed form fields and save the PDF to make the changes
permanent.

3.2.1 — Electronic Signature Box

Place the mouse pointer on the electronic signature box. The mouse pointer will change from
default pointer to a hand sign. Now clicking on the electronic signature box will initiate the act-
of-signing. Once the act-of-signing is complete, the fields that are set to be made read-only
when this field is signed become read-only.

If the Electronic Signature Box was created or the properties were edited in any another PDF
manipulation tools, the only property that is honored by pDoc Signer is the “Mark as Read-
only”. Any other properties that have been set are ignored in pDoc Signer.

9 www.topazsystems.com
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3.2.2 — Text Box

If the Text Box was created or the properties were edited in any another PDF manipulation
tool, the properties that are honored by pDoc Signer are “Tooltip” and “Multi-line”. Any other
properties that have been set are ignored in pDoc Signer.

3.2.3 — Radio Button

If the Radio Button was created or the properties were edited in any another PDF manipulation
tool, the properties that are honored by pDoc Signer are “Tooltip” and if buttons with same
name and export value are selected in unison or not. Any other properties that have been set
are ignored in pDoc Signer. Also, the presence of special characters like "#% () /[]{<>;"In
the export value might lead to unexpected behavior in pDoc Signer.

3.2.4 — Check Box

If the Check Box was created or the properties were edited in any another PDF manipulation
tool, the properties that are honored by pDoc Signer are “Tooltip” and the export value. Any
other properties that have been set are ignored in pDoc Signer. Also, the presence of special
characters like "# % () /[]{ <> ;" in the export value might lead to unexpected behavior in
pDoc Signer.

3.2.5—List Box

If the List Box was created or the properties were edited in any another PDF manipulation tool,
the properties that are honored by pDoc Signer are “Tooltip” and if the list box allows multiple
selection or not. Any other properties that have been set are ignored in pDoc Signer.

3.2.6 — Combo Box

If the Combo Box was created or the properties were edited in any another PDF manipulation
tool, the properties that are honored by pDoc Signer are “Tooltip” and if one can enter custom
text into the combo box or not. Any other properties that have been set are ignored in pDoc
Signer.

3.2.7 — View Properties of Form Fields

You can view the properties of the existing form fields by right clicking on them and then by
selecting the properties menu options.

Clicking on “Properties” displays the properties window of the particular form field and
populates the information of the form field in the displayed window. The properties displayed
will depend on the type of the form field being selected. Grayed out boxes imply that the values
cannot be changed.

10 www.topazsystems.com
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File Tools About

B 8|7

';TE—]T,‘.W O R

Johne Doe |

=3
E Properties
Al
4

3.2.8 — Setting the Font Options

To set the font options for the entries displayed in form fields and comments, go to
“Tools—>Preferences”. Click on the “Font” tab and select the Font options such as Font Name,
Font Style, Font Size, Font Color, and Font Effects such as underline. The selected effects will
be applied to the sample text. Once the desired options are selected, click on ‘Apply’. Note
that the default font settings are Times New Roman, Regular Face, Size 12, No Underline, and
Black.

Font Options
Font Name Font Style Faont Size

Times Mew Roman Regular 12 W

Font Effects Sample

[ ] underline D SigﬂEI

| coo

*These font options apply to entries displayed in form fields and comments.,

Note: The font settings apply to the presentation of text in form fields and comments on your
display. When the PDF is rendered (for example when it is printed, opened in Print Preview, or
opened in another PDF application), the PDF default font Helvetica is used, and the font size is
determined by the size of the field and the length of the text.
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3.3 — Electronic Signatures

pDoc Signer allows one to insert an electronic signature field and sign it immediately using the
“Insert & Sign” toolbar icon. This toolbar icon is displayed by default.

3.3.1 —Insert and Sign

File Tools About Select the ‘Insert and Sign’ icon on the tool
= 1 | 7 =T !» bar. The mouse pointer will change from

default to cross bar.
| Insert & Sign Electronic Signature Box i

Nl

File Tools About Now drag the mouse on the
— _— = document to the required size and
—— ‘ FET # 1 = o 1] |ocation of the signature field. Upon
* completion of the selection, the
_ signature field is displayed as
& o ; shown here and the act-of-signing
— ] : is initiated.
+
e
4)

If the signature field size selected is less than 15 pixels (for both width and height), the
signature field is treated as invalid and a message is shown saying “You are trying to create a
signature field that is too small. Please create a larger signature field”.

3.3.2 — Signature Capture Process

During the signature capture process, additional information like First Name, Last Name and
Email can optionally be input or one can select a pre created signer from the list of signers
(see Section 3.3.8).

If the signer is not satisfied with the signature input, one can click on “Clear” and sign again. If
the signer wants to abort the act-of-signing, one can click on “Cancel”. Canceling the signature
capture process will delete the digital signature field too.

Once the signer is satisfied with the signature input, clicking on “OK” will affix the signature to
the document.

12 www.topazsystems.com
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4
Signature Information

First Name(s): |John Last Mame: |Doe

Email: johndoe @doe. com|

Select Signer:  |None v

Signature Pad initialized properly. Start signing...

S\ Dee

—_

The licensed version of pDoc Signer supports signing using Pen Display devices. If a Pen
Display device is connected to the PC, the signature capture screen is displayed on the Pen
Display (an extended monitor). The signer can use the stylus that is attached to the Pen
Display to scribble the signature.

3.3.3 — Validation of Signatures

By default, signatures are validated when you open a PDF in pDoc Signer. An icon appears in
the signature field on the document page to indicate the signature status. Further details about
the status appear in the Signatures panel and in the Signature Properties dialog box.

e The digital signature iconEEE=along with the name of the field in the Signatures panel
indicates the presence of an unsigned signature field.

g
¥
e The check x mark icon indicates that the signature is valid.
e The red X icon indicates \f'/ that the signature is invalid.

e The caution triangle icon indicates that the document was modified after the signature
was added.

e The question mark icon indicates that pDoc Signer is not able to verify
the signature.

The Signature Properties dialog box can be invoked either by clicking on the Status icon or by
right clicking on the Signature Field and then selecting the “Validate Signature” option. Clicking

13 www.topazsystems.com
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on the “Validate Signature” menu validates the signature first and then displays the Signature
Properties dialog box.

See the screenshots below for reference.

Unsigned Field Icon:

2872 T /27K K

El

Status icons and validate right click menu:

File  Toals  Abouk

_B / LE] T f 4 4 | 1 ~ofl é;}

g’mu
DCrata: 2004 .0§. -08:00
::-d- 1IEH . IM

vi
Demo " r
Date: EE' D€ A¥Bbrs -0a W Validate Signature

Wiew Signed Yersion

Properties
ema
Date: 1 as-08:00

S WL B

The status icons on the signed signature fields can be turned off by unchecking the option

“Show signature validation status tick marks” option in the “Signature Field” tab of the pDoc
Signer Preferences screen.
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Pendl | Date Format

(") Prompt for Signature field name during field insertion

(® Automatically insert Signature field name

Signature field name prefix:  |pDocSigner

Signature Field Transparency

Show signature validation status tick marks

If the option "Show signature validation status tick marks" is unchecked, then depending on the
status of the document, the following are displayed in the status bar.

e If no signature is present in the document, then the status is displayed as “Document
not signed”

e If only one signature is present in the document and there have been no changes to the
document after the signature, then the status is displayed as “Signature valid and
document unchanged since signing”.

¢ If only one signature with subsequent changes is present in the document, then status
is displayed as “Signature valid but document has been changed.”

¢ If more than one signature is present in the document, then status is displayed as
“Signatures valid but document has been changed.”

¢ If one or more signatures are corrupted, then status is displayed as "One or more
signatures are invalid."
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Signature Properties Dialog box:

Signature Properties

¥erification Details signer Details

Signed: |2/8/2013 9:18:45 AM | First Mame: iJohn |
L

Verified: |2(8/2013 9:18:49 AM | Last Name: |poe |

| Signature Yalid - The document has not Email: %-]:Enhndoe@johndoe.com i
been modified since the signature was

applied.

W alidity:

Certificate Details

Issued To: | Ch=pDo Signer | Serial No; | BSET72A40DA100A044B9475062490027 |

I &
Issuer: (CN=pDoc Signer | Wersion Mo |3 |

Public Key Algorithm: |RSA (1024 bits) |

i FDBESIE1EF10FDY 944765 3FE45453C20
Thurnbprint: | Z0BESOBL

3051990261510089E1 21 SE0873303066 A
; 59952 40F4E257 LDACI649E4BB2AEGT
Public Key Data! | 4p4cosE733a6576AC3AFIBI6FE96EFER

valid From: |1/1/2012 12:00:00 A4 | =
Signature Algorithm: |sha1RS.ﬁ. (1.3.14.3.2.29)

walid To: | 1112015 12:00:00 A1 |

305201F430820161A0030201 02021085
E77Z2A400A100A344E94 7596249302730

090605260E0302100500301631143012

Faw Certificate Data:

3.3.4 — View Signed and Unsigned Signature Fields

Click on the ‘Signatures’ tool button in the left

) . File Tools Ab
pane to open the signature panel. The width of te fook  About

the signature panel can be increased or = Eﬂ 712 T f| .
decreased as required by using the splitter ) [ = Unsined Signature Fields
between the panel and the document page. The .~ pDocSigner 1 on Page 1

i - pDocSigner Zon Page 1
EI Signatures

EI pDocSigner 3 on Page 1

- Signature Tite: Demo Demo

- Time: 2015-06-16 T02:12:40-07:00
- View Signed Version

[=)- pDocSigner 4 on Page 1

- Signature Tite: Demo Demo

list of signed and unsigned signature fields
along with details is displayed.

If we click on any of the signature fields in the
list, the corresponding blank or signed signature

SN[

field in the document will be highlighted as - Time: 2015-06-16 T02: 13:01-07:00
shown in the screenshots below. Close the - View Signed Version

signature panel by clicking again on the
‘Signatures’ tool button.
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File Tools About

E”/ =T j| 4 1 - ofl| D P 100% -

E-Unsigned Signature Fields | e emmemmmmmmm———————

: pDocSigner 1 on Page 1 .E; !

i . pDocSigner 2 on Page 1 : '

H ]
[=)- Signatures ] '

A 1 1

1

EI pDocSigner 3 on Page 1 K
i i-Signature Title: Demo Demo
- Time: 2015-06-16 TO2:12:40-07:00

{0 b View Signed Version B>
EI pDocSigner 4 on Page 1
Signature Title: Demo Dema
E----Tlme: 2015-06-16 T02:13:01-07:00

‘- View Signed Version

a=r !

=

File Tools About

E]|/ =T /'| 4 1w ofl| D P 100% -
=- Unsigned Signature Fields
.~ pDocSigner 1on Page 1 [Eannere:
... pDocSigner 2 on Page 1

EI Signatures
B pDocSigner 3 on Page 1
Signature Title: Demo Demo
- Time: 2015-06-16 TO2: 12:40-07:00
i - View Signed Yersion
B pDocSigner 4 on Page 1
- Signature Title: Demo Demo
- Time: 2015-06-16 T02: 13:01-07:00

- View Signed Version

Y=

One can also use the arrow keys (i.e., up and down) or the TAB key to navigate through the
list of signatures in the signature panel and select a signature.

3.3.5 - Viewing Previous Versions of a Signed Document
Each time a document is signed in pDoc Signer, a signed version of the PDF is saved with the

PDF. Each version is saved as append-only so that it cannot be modified. In pDoc Signer, the
corresponding signed version of a signature can be viewed using the two following options.

17 www.topazsystems.com



PAZ pDoc Signer User Manual
SYSTEMS INC.

1. In the Signatures panel, select the signature, and click on the “View signed version”
option available in the details of the signature.

2. Right click on the signed signature field and select “View Signed Version” from the list of
available options.

See the screenshot below that displays the options mentioned above.

File Tools About

EBZIET | W4 [o [fere| 2 4@ [1o0% [

(=]~ Unsigned Signature Fields
Sample Signature Field on Page 4
ignatures 3. Family History 4. Payment Method
[=)-Patient on Page 9
Signature Title: Demo Demo VISA
Time: 2015-06-16 T02:20:31-07:00 Check for family members still living
View Signed Version
E| Patient Representative on Page 9
‘- Signature Title: John Doe
E----Tlme: 2015-06-16 TO2:21:20-07:00
‘... View Signed Version

Mother
Father

Nz Y

Maternal Grandmother
Maternal Grandfather

Paternal Grandmother

SEEEEE

Paternal Grandfather

5. How did you hear about us (select all that apply)

Internet Search ~

[] Insurance Company Referral

6. Approval Signatures

We affirm that the information above is correct and that we are responsible for timely payment of all bills
for treatment of patient.

vl LT
Demo De v Validate Signature 3 W\/}
2015-08-16 T02:20:31-07:00 -1.6_[52%:2 0700

View Signed Version
Patient - epresentative
Properties

Selecting one of the options specified above displays the signed version PDF in another
instance of pDoc Signer in which the only options available to the user are scrolling through
the document, zooming, the signature panel as shown below and saving the PDF using “Save
As” option if required.
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File  About
4D M T2 o -
&
&
3. Family History 4. Payment Method
Check for family members still living VISA
] Mother
7] Father
] Maternal Grandmother
Y] Maternal Grandfather
] Paternal Grandmother
[¥] Paternal Grandfather

5. How did you hear about us (select all that apply)

Internet Search

Insurance Company Referral
Newspaper Ad
Friend

6. Approval Signatures

We affirm that the information above is correct and that we are responsible for timely payment of all bills
for treatment of patient.

Demo Demdﬁ/v‘“’o
2015-06-16 T02:20:31-0700

Patient Patient Representative

3.3.6 — Specifying Signature Field Options

Each Signature Field must have a name associated with it. pDoc Signer can assign a name to
a signature field automatically when a Signature Field is inserted into a PDF document if a
“Prefix” for Name is supplied. Another alternative is to provide a name for the signature field
when inserted manually. These options can be set in the “Signature Field” tab under
“Tools—>Preferences”.

If the option ‘prompt for Signature field name during field insertion’ is selected, a window

prompting for a Name for the signature field gets displayed when a signature field is inserted in
the PDF document using pDoc Signer.
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Signature Info | Signature Capture Font | Pendl | Date Format

() Prompt for Signature field name during field insertion
(@ Automatically insert Signature field name

Signature field name prefix: | pDocSigner

Signature Field Transparency
Show signature validation status tick marks

If the option ‘Automatically insert Signature field name’ is selected, then the signature field
name Prefix will be appended with the next number in the sequence of created form fields and
set as signature field name for both the blank signature field and during signing.

Select the “Signature Field Transparency” option if the signature field should be transparent on
the PDF document. The option is checked on by default.

Select the “Show signature validation status tick marks” if the signature status icon should be
displayed on signed signature fields.

3.3.7 — Signature Capture Options

To set the Signature Capture options, go to “Tools—>Preferences”.

Pendl | Date Format

Signature position with respect to the details: | gaping

Signature Processing
Maximum Enlargement Percentage |25

Signature Drawing Option

Ink Color: - Colar
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Select the signature position with respect to the signature details, i.e., the signer name and the
date/time the signature was collected. The three options available are “Behind”, “Beside”, and
“Image Only”.

Signature Info | Signature Capture | Signature Field | Font | Pendl | Date Format

Signature position with respect to the details: | gaping

Signature Processing Beside
Image Cnl
Maximum Enlargement Percentage |25 8 Y

Signature Drawing Option

Ink Color: - Color

If the option “Behind” is selected, the signature details are placed at the center of the signature
field with the signature squiggle behind the details as shown below.

v
Demo
Date: 201 2‘%]{3@ -08:00

If the option “Beside” is selected, the signature squiggle is shown on the left side of the field
and the details are shown on the right side of the signature field as shown below.

y/ Demo
“r Date: 2013.02.19
QW) 233457 -08:00

If the option “Image Only” is selected, only the signature squiggle is shown in the Signature
Field and details are not shown.

-

75 3 _
j / oN HI )
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One can specify if the Maximum enlargement feature is enabled or not and also specify the
maximum enlargement percentage. The Maximum Enlargement Percentage is used only in
cases where the size of signature on the signature pad (after white space removal) is smaller
than the size of the Signature Field in the document. When the signature drawn on the
signature pad is smaller than the size of the Signature Field in the document, pDoc Signer will
enlarge the signature to fill the Signature Field. However, it will limit the enlargement to the
value of the Maximum Enlargement Percentage. The Maximum Enlargement Percentage
specifies the percentage of the destination to use in such cases. This prevents the signature
from looking too pixelated or jagged. The value of the maximum enlargement percentage can
be between 0 and 100. If a value of O is specified, the signature is not enlarged at all. If a value
of 100 is specified, the signature is enlarged to fit the complete destination.

One can also specify the default ink color for the signatures in this screen by clicking on the
“Color” button. The default color is Blue.

The Prefix and Date/Time format for date presentation in signature details can be specified in
the “Date Format” tab of the Preferences screen.

Signature Info | Signature Capture | Signature Field | Font | Pend

Date Presentation Options in Signature Details
Prefix:
(Mo Prefix)

Date,/Time:
Y'Y -MM-DOThh:mm:ss £hh:mm (International)
Preview:

2014-09-19T03:49:03+05:30

Note: The display of Signature Title and the time/date stamp is on by default and non-
removable for “Behind” and “Beside” options. But, if the height of the signature field is less than
30 pixels or the width of the signature field is less than 50 pixels, then the signature details
(i.e., Signature Title and Date/time stamp) are not printed on the signature.

3.3.8 — Signature Information

1. Creation of List of Signers

This feature can be used to create a list of signers for the purposes of signing. During
signing, in the signature capture screen, the list of signers available is displayed and a
signer can be selected from the list. Each profile contains First Name, Last Name and
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Email of the signer. To create a profile, enter the required information and then click on
the “Add” button. Once created, the Signer Information (i.e. First Name and Last Name)
is added to the Signers List.

A maximum of 10 profiles can be created here for use while signing.

Signature Info | Signature Capture | Signature Field | Font | Pendl | Date Format
Default Signature Info

First Mame(s): [John
Last Mame: |Doe

Email: |johndoe@johndoe. com

Add Remaove

Select Signer:  |Oghn Doe

To make a signer the default signer, select the Signer from the available list of Signers
and then click on OK. During the signature capture process, the selected signer
information is pre-filled in the signature capture window.

2. Remove a Signer from the List

To remove a signer from the list, select the signer from the available list and then click
on the “Remove” button.
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Signature Info | Signature Capture | Signature Field | Font | Pendl | Date Format
Default Signature Info

First Mame(s): |John

Last Mame: |Doe

Email: |johndoe@johndoe. com

Add Remove

Select Sianer: | Ighn Doe

3.3.9 — Automatic Configuration of Certificate

pDoc Signer provides a default certificate for signing. The default certificate will be configured
automatically during the installation of the pDoc Signer. If the user wants to change the
certificate during signing, the user needs to go the “Select Certificate for Signing” in the “File
Menu” and configure the certificate as shown in the certificate selection section.

3.3.10 — Certificate Selection

Signing in pDoc Signer requires the use of a digital certificate. During its installation process,
pDoc Signer automatically installs and configures a certificate that is used by default for
signing. Users should select a different certificate that represents their organization. To select
another certificate for signing, go to “File > Select Certificate for Signing...”. Selecting that
option opens a window titled Select Certificate for Signing. In that window, the certificate path
(i.e., PFX Path) to the previously selected certificate (or to the default certificate) will be shown.
By default, the certificate path is set to the certificate (i.e., pDocSigner.pfx) that is installed and
configured automatically during the pDoc Signer installation; the password for the default
certificate is “pdocsigner”. To select another certificate for signing, browse to that certificate
with the Browse button, then enter the password in the Password text box, and click on the OK
button.
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Select Certificate for Signing

Certificate Path iE:_'l,i:'ngram FilespDac SigneripDocSigner . pfx | Browse

Password ; Elllliiilll |

I Cancel ]

3.4 — Sticky Note Comments

pDoc Signer allows insertion of sticky note comments in a PDF document. Sticky note
comments are notes that communicate ideas or provide feedback for PDFs. You can type a
text message using the sticky note comment tool. Text editing tools let you add editing marks
to indicate changes you want in the source document.

Most comments include two parts: the icon, or markup, that appears on the page and the text
message that appears in a pop-up note when you double-click the icon.

3.4.1 — Adding Sticky Note Comments

Click on the sticky note comment tool button. The mouse pointer changes from the normal
default arrow to an arrow with a sticky note comments icon attached to it. The sticky note
comment field button is shown in the image below.

File Tools About

= | /

IQ,E_JT/" | 1 |+]of1

| Insert Sticky Mote Cornment

F
Now click on the document where the sticky note comment field is required. A window is

displayed wherein the user can add the text for the comment. The image below shows the
sticky note comments input window.
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&4 Sticky Mote Comment E|

pDoc Signer Sticky Note Comment

Upon acceptance, a sticky note comment icon will be displayed on the document at the
specified location which indicates that the sticky note comment field is added in that position.

File Tools About

=l =15,

|§T,‘|PM

Y=
|

3.4.2 — Viewing Sticky Note Comments

Double click on any sticky note comment icon on the document. Sticky note comments
corresponding to the selected sticky note comment icon are displayed in a separate
transparent window.
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File Tools About

=4 =5

ETZHA DM oo P4

Sticky Note Comment IEI
6/16/2015 2:35:43 AM

S[NP|

Sample Sticky Note Comment

3.4.3 — Deleting Sticky Note Comments

To delete a Sticky Note Comment, select the comment and then right click on it. Select the
“Delete” option. The user is prompted with a confirmation message that says "Do you want to
delete the selected Sticky Note Comment?" Upon Clicking “Yes” the sticky note comment will
be deleted.

File Teools About
EOZI®T M4 P M o] £

AR

Delete

Note: You cannot delete a sticky note comment if the PDF document contains at least one
signed signature field or if the PDF is secured.
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3.5 — Text Comments
pDoc Signer allows insertion of Text Comments in a PDF document. Text Comments are notes
that communicate ideas or provide feedback in PDFs. You can type a text message using the

Text Comment tool. Text editing tools let you add editing marks to indicate changes you want
in the source document.

3.5.1 — Adding Text Comments

Click on the text comments tool button (the capital letter “T”). The mouse pointer changes from
the normal default arrow to cross hair. The text comments field button is shown in the image
below.

File Tools About

E8|Z ST

et

| Insert Text Comment i

-
R

F
=

Now drag the mouse on the document to the required size and location of the text comments
field. Upon completion of the selection, the text comments field is displayed as shown below
and the text comments input window is displayed.

File Tools About

iI=IFAISE W4

P P 1 |7]ef9

-5
Q
LS

Using your keyboard, enter the text for the comment. Font attributes specified in the
Preferences windows for comments are applied for the text entered in this window.
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Text Comment @

Enter kext For the bext caomment;

pDoc Signer text comments

Click on the “Add” button to the text comment to the PDF. The screenshot below shows the
text comments added in the PDF document.

File Tools About

1=15

IL,;_]T/" | PP [|efe
L

A
2
&

pDoc Signer Text Comment

Note:

1. If the text comments field size selected is smaller than 15 pixels wide and 5 pixels high,
the text comments field is treated as invalid and a message is shown saying “You are
trying to create a text comment field that is too small. Please create a larger text
comment field”.

Text lines that are longer than the width of the text field are truncated by standard
convention; they do not automatically wrap to the next line, so you should use line
returns for multi-line comments.

N

3.5.2 — Updating Text Comments

The existing text comments can be updated in pDoc Signer. Click on the text comment and
alter the text as required. The updated text is applied to the text comment when the PDF is
saved. The screenshot below shows a text comment after updates.

29 www.topazsystems.com



pDoc Signer User Manual

SYSTEMS INC.
File Tecls About
=l = IFAISE Wy D D[ []ers]
L
ﬁ pDoc Signe]

F
=

Note: Text comments in place when the document is signed will not be editable after signing;
however, after a document is signed new text comments can be added, but they cannot be
modified after addition.

3.5.3 — Deleting Text Comments

To delete a Text Comment, select the comment and then right click on it. Select the “Delete”
option. The user is prompted with a confirmation message that says "Do you want to delete the
selected Text Comment?" Upon Clicking “Yes” the Text Comment will be deleted.

File Tools About

EB|IZSET L

PP vnfﬂ"

Delete

=5
E pDoc Siener
.
el

Note: You cannot delete a text comment if the PDF document contains at least one signed
signature field or if the PDF is secured.

3.6 — Pencil Tool

The Pencil tool creates free-form drawings and the Pencil Eraser tool removes the pencil
markups.

3.6.1 — Draw Pencil Markup
Click on the pencil tool. The mouse pointer changes from the default pointer to a cross bar.

Drag where you want to begin drawing and release the mouse button where the pencil line
should end. The pencil markup with selected color and width will be drawn on the page.
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File Tools About

=4 =1

LTE—]T,‘.'I | P MC‘”“

| Insert Pencil Markup i

Pl

File Tools About
_E”/ LE—]TI’| M4 P [>‘|°f9|¢')¢")
.|

SYSTEMS INC.

YR

Introduction Guide

pDoc Signer

=

3.6.2 — Delete Pencil Markup
To delete a Pencil Markup, select the markup and then right click on it. Select the “Delete”

option. The user is prompted with a confirmation message that says "Do you want to delete the
selected Pencil Markup?" Upon Clicking “Yes” the Pencil Markup will be deleted.
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File Toeols About
EBZ|ET A4 P M| 2 2o [
=
Y
J,' SYSTEMS INC,
Y

Introduction Guide

/;Doc
K De_l-e.tif |—|

1l

Note: You cannot delete a pencil markup if the PDF document contains at least one signed
signature field or if the PDF is secured.

3.6.3 — Settings For Using the Pencil Tool

To specify the line width and line color for pencil markups, go to “Tools—>Preferences”. Click on
the ‘Pencil’ tab, select the Pencil line color and width of the line and click on *‘Apply’.

Signature Info | Signature Capture | Signature Field | Font | Pendl | Date Format

Pencil Drawing Options

Line Color: - Color

Line Width: |3

3.7 - Attachments

One can attach PDF documents and other types of files to a PDF. If you move the PDF to a
new location, the attachments move with it.

Click on the ‘Attachments’ tool button at the left pane to open the Attachments panel. The
existing attachments list with ‘Attach’, ‘Delete’ and ‘View’ buttons are displayed.
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3.7.1 — Adding Attachments

File Tools About )
File Tools About

‘ = T ‘ | B —_— .
i Attach e Ve d Attach Delete View
E’l ----- Attached Files List p— _ -

& [=I- Attached Files List
— i Dema, bt
45: P ‘.. Sample.pdf
- =
& P

Clicking on the ‘Attach’ button will open a file dialog. Select the file to be attached to the PDF
document and click “OK”. The selected file will be attached to the document and the attached
file list will be updated.

3.7.2 — Delete Attachments

Select the attachment to be deleted from the list. File Tools About

Now click on the ‘Delete’ button present in the o .
Attachments panel to delete the attachment. The B | / =T , ‘ N b
selected file will be deleted and the attached files list =8, e = —

will be updated. —
[=)- .ﬁ._tlad'led Files List

Note: You cannot delete a file attachment if the PDF IB‘
document contains at least one signed signature +~5ample.pdf
field or if the PDF is secured.

£
&
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3.7.3 —View Attachments

To view an existing attachment, select the attachment and click on the ‘View’ button in the
Attachments panel. If the attachment is a PDF, it is opened in another instance of pDoc Signer.
For other types of attachments, the attachment is opened in their respective application.

3.8 — Securing Documents

pDoc Signer can be used to secure an unsecured and unsigned PDF.

For securing a document, go to “File->Secure Document”. The secure document dialog is
displayed. Provide either “Permissions Password” or both “Open Password” and “Permissions
Password”. “Permissions Password” is mandatory. The default operations allowed for secured

documents are printing is not allowed and form filling and signing, comments, pencil drawing
and attachments are allowed.

Upon clicking “OK”, the document is secured with the information provided and is closed. The
secured document must be opened again for further use in the pDoc Signer tool.

& Secure Document E|

Cpen Password: ! |

Permissions Password®: | |

Select the operations allowed For secured documents

Prirking Allowed: |Nu:une w |

Changes Allowed: |E><isting field signing, Form fields Filling,comments, pencil drawing and attachrments  » |

*Note: Open Password is optional but Permissions Password is mandatory.

[ o | [ o=

Open Password: One will be prompted to enter this password when the document is being
opened.

Permissions Password: One will need to provide this password if permissions on the
document need to be modified at a later point of time in other PDF containers. Permissions
password once provided cannot be changed in pDoc Signer.

Printing Allowed: Two options are available for the user to select print permissions.

& Secure Document E|

None: If the user selects the “None” . .

option in the printing allowed, the IR !

secured documents are not allowed for | rermissions password*: | |

prl ntl ng ! Select the operations allowed For secured documents
Printing Allowed: |None V_i
Changes allowed: _-ﬂllw Prinking

34 WWW.

*Note: Open Password is optional but Permissions Password is mandatory.
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Allow Printing: If the user selects the “Allow Printing” option in the printing allowed, the secured
documents are allowed from printing.

Changes Allowed: Five options are available for the user to select the changes allowed on
the PDF.

None: If the user selects the “None” option in the changes allowed, no changes are allowed on
the PDF after securing the PDF.

Existing field signing and form fields filling: If the user selects the “Existing field signing and
form fields filling” option, the secured document will allow existing form field filling and signing
of existing blank signature fields. All other operations are disabled.

Existing field signing, form fields filling, comments, pencil drawing and attachments: If the user
selects the “Existing field signing, form fields filling, comments, pencil drawing and
attachments” option, the secured document will allow existing form fields filling, signing of
existing blank signature fields, insertion of comments, insertion of pencil drawing and adding
attachments in the secured documents. All other operations are disabled.

Insertion and deletion of pages: If the user selects the “Insertion and deletion of pages” option,
the secured document will allow only insertion of the pages and deletion of the pages in the
“Manipulate Pages”. All other operations are disabled.

All allowed except extract pages: If the user selects the “All allowed except extract pages”
option, the secured document will allow all the operations except “Extract Pages” in the
“Manipulate Pages”.
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& Secure Document E|

Cpen Passwiord: | |

Permissions Passward®; | |

Select the operations allowed for secured documents

Prinking Allowed: | Mone v |

Changes Allowed: | Existing field signing, Form Fields Filing, comments, pencil drawing and attachments s

Mone
*Note: Open PasE xisting field signing and Form fields filling
Existing Field signing,Form Ffields filling, comments, pencil drawing and attachments

Insertion and deletion of pages
Al allawed except exkract pages

3.8.1 — Opening Secured Documents

When opening a document having “Open Password”, a dialog is displayed prompting for
“Open Password” to open the document. If the user provides the correct password, then the
document is opened, otherwise an error message will be displayed.

& Open Password &|

This document is password protected. Please provide
open password.

(o J (e |

If the document being opened had a “Permissions Password” too, features of pDoc Signer are
enabled or disabled based on the Permissions set while securing the PDF.

If the document being opened has only the “Permissions Password”, the password dialog is
not displayed, but features of pDoc Signer are enabled or disabled based on the Permissions
set while securing the PDF.
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3.9 — Printing and Print Preview

To print the opened PDF document from pDoc
Signer, click on the ‘Print’ tool button on the & Print
vertical toolbar or go to “File>Print”. The print General |

dialog will be opened. Select the Printer, one S
of the options All, Current Page, or Page n
Range, and click on Print. The document =2

. . Add Prinker Adobe POF
pages are printed on the selected printer.
To view the appearance of the printed s i
document before actually printing it, the “Print Commert
Preview” function can be used. This function Page Flange
can be invoked from “File -> Print Preview” or @Al Nurnber of copiss:
the “Print Preview” tool button on the vertical © Current Page

H H “ H H ” Pages: 1-42

to_olbar. Cllcklr_lg on “Print Preview opens a Eonter jthelaSinge — @
window that displays the document as it will be page tange. For example, 512
printed. The only toolbar icons available in this
window are for page navigation and printing Pt | [ Cancel |

the document. To print a document in the Print
Preview window, simply click on the Print icon.

3.10 — Merging and Splitting of PDF Documents

3.10.1 — Extract Pages

To extract (copy) pages from t_he opened PDF
document, go to “Tools->Manipulate

: : Pages—>Extract pages”. In the Extract Pages
il o D s dialog, select the page range (i.e., starting page
to ending page) and click the “OK” button. A
dialog prompting the user to select the folder
where the new PDFs should be created is
displayed. Once the folder is specified, the
selected pages will be embedded into the new
PDF with same name as the original PDF and having a suffix “_Extract”. For example, if the
opened PDF name is “Demo.pdf’, the new PDF name would be “Demo_Extract.pdf”. If the
option “Extract Pages as Separate Files” is selected, each of the pages is exported into a new
PDF document, and the page number is appended to the file name for each page in the
document.

|:| Extract Pages As Separate Files

o ] [ o= |

Note: Any signature fields (both unsigned and signed) existing in the page are removed from
the page during the extraction process. Signature Fields should be inserted again if required.
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3.10.2 — Delete Pages

To delete pages from the opened PDF document, go

to “Tools ->Manipulate Pages—->Delete pages”. In the
— e Delete Pages dialog, select the page range (i.e.,

Fram: |2 | Ta: |5 | ofi2 i i .
S B starting page to ending page) and click the “OK”
button. Upon clicking OK, the selected pages will be
ok eaiel permanently deleted from the opened PDF.

[ insert P
3.10.3 — Insert Pages nsert Pages

To insert pages into the opened PDF document, go to fpzsttElns Hew R DRnoeR et
“Tools—>Manipulate Pages—>Insert Pages”. Select the PDF Location: | after ¥
file from which the pages will be inserted in to the opened Bage

PDF document from the file dialog. The Insert Pages dialog ) et

will be opened, select the location at which the page will be O Last

inserted (i.e., after or before). Select the page number at
which the pages will be inserted (i.e. First or Last or page
number). The selected PDF pages will be inserted in the | | | concel
specified location.

@ pPage: |1 | of 19

3.10.4 — Replace Pages

To replace the pages in the opened PDF document with the selected pages from another PDF
document, go to “Tools—>Manipulate Pages->Replace Pages”. Select the document that
contains the replacement pages and click
“Open”. Once the document containing the
replacement pages is selected, the Replace

Replace Papes

. . Criginal
Pages dialog will be opened. replcepages: 1| Tar 1| ot
In the Replace Pages dialog, under Original, ikt dmantadi
specify the pages you want to replace. ET—
Under Replacement, specify the beginning e Ll o

page as shown in the image at right. e

from ‘Loan Docurment_1.pdfF

ok ‘ [ Cancel

Case 1. Page Range to be replaced is more than the total number of pages of the
Replacement document.
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Replace Pages E|
Criginal
Replace Pages; |1 | Tao: |5 | af 11

in 'Loan Document, pdf!

Replacement

With Pages: To: Pof 4

from ‘'Loan Document_1,pdF

o | [ o=

In the above figure, replace pages are from Page 1 to 5, but in the replacement PDF document
we have only 4 pages.

In this case, only the first 4 pages of the original document are replaced with the 4 pages from
the replacement document and the 5th page of the original document would remain as-is. The
following screens display the original PDF document before the replacement operation and

Before replacement

Dao@EEaEaaa

PDF 1
P1 P2 P3 P4
PDF 2

after the replacement operation.

After replacement

e ||ll p2 ||| P2 pr || ' | | ' '
of of of “of P5 P6 P7 P8 P9 P10 | | P11
PDF2 | | PDF2| | PDE2| |PDF2

PDF 1
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Case 2: Page Range to be replaced is same as the [EFIFLEes X
total number of pages of the Replacement —
document, but the starting page is not the first RepacePagest [1 | Tor[1 | o1t
page in 'Loan Docurnent.pdF! -
In the figure at right, pages to be replaced are from Replacement
1 to 4. The total number of pages in the withPages: [z | Toi 77rofs
replacement PDF document is 4. But the starting from ‘Loan Docurent_t.peF
page specified in the replacement document is 2,
which indicates that only three pages from the = ][ e |

replacement document are available for
replacement. In this case only 3 pages of the original document will be replaced by the 3
pages of the replacement PDF document. The 1st page of the original document would be
replaced with 2nd page of the replacement document and the 2nd page of the original
document would be replaced with the 3rd page of the replacement document and so on. The
4th page of the original document will be remain as-is.

The following screens display the original PDF document before the replacement operation

Before replacement

._\ | _I. .’d—,! L_, l;“\. _ I4 —t_— __. __ | _ I ‘d _l

P1 P2 P3 P4 PS5 PG P7 P8 PO P10 P11
PDF 1
P1 P2 P3 P4
PDF 2

and after the replacement operation.

After replacement

P2 P3 P4

of of of P4 PS5 P6 P7 P8 PO P10 P11
PDF2 | | PDF2| | PDF 2

PDF 1

Note:

1. Only Extract Pages feature is enabled if the PDF document contains at least one signed
signature field.
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2. If the PDF opened is a secured PDF, depending on the options selected while securing, one
or more of the above page manipulation functions are enabled.

3.11 — Command Line Arguments

In addition to opening the pDoc Signer application using Start > Programs = pDoc Signer -
pDoc Signer, pDoc Signer can also be invoked from the command prompt or from other
applications by running the pDocSigner executable located in the pDoc Signer installation
folder. The pDoc Signer application accepts “FilePath” as a command line argument. Any third
party application that wants to invoke pDoc Signer can run the pDoc Signer executable using
the Windows API and provide the path of the file to be opened as a command line argument.
For example, clicking on “Start >Run”, and then running the command “C:\Program
Files\pDoc Signer\pDoc Signer.exe” “C:\Sample.pdf’ opens the pDoc Signer application and
opens the “C:\Sample.pdf” automatically. The above command assumes that pDoc Signer is
installed in the “C:\Program Files\pDoc Signer” folder. This feature is particularly useful for
custom third party applications to invoke pDoc Signer from their application.

3.12 — Recent File List

The pDoc Signer application maintains a list of 5 recently opened documents and the list can
be seen in the “File” menu.

4.0 — Appendix

4.1 — pDoc Signer Silent Installation Instructions

In your administrator PC:

1. Uninstall pDoc Signer if it is already installed.

2. Open the Command prompt.

3. Navigate to the folder where the pDoc Signer installer resides.
4

. Type pDocSignerX.X_RXXXX.exe /r and replace the X.X_RXXXX with the actual version
numbers of the pDoc Signer software to start the installation in a dialog mode to create a
response file that will be used during the silent install.

5. Once the installation is complete, the response file named Setup.iss will be created in the
Windows folder; for example, if XP is the OS and the OS drive is C:\, then the Windows
directory is C:\Windows.

6. Take a copy the pDocSignerX.X_RXXXX.exe file and the Setup.iss file to use for silent
installation.

To perform silent installation on other PCs:
1. Copy the pDocSignerX.X_RXXXX.exe file and the Setup.iss file created above to a local
folder on the PC where pDoc Signer is to be installed.

2. Open the Command prompt.
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3. Navigate to the folder where the pDocSignerX.X_RXXXX.exe file and the Setup.iss file are
located.

4. Type pDocSignerX.X_RXXXX.exe /s /f1"<Setup.iss Path>".Replace the X.X_RXXXX with
the actual version numbers of the pDoc Signer software, and replace <Setup.iss Path> with
the path name to the folder where the Setup.iss file is located; for example, if
pDocSignerX.X_ RXXXX.exe and Setup.iss are located in the C:\Temp folder, then the
command would be pDocSignerX.X_RXXXX.exe /s /f1"C:\Temp\Setup.iss".

5. The pDoc Signer installation will start in silent mode and complete automatically without
any user intervention.
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4.2 — Making pDoc Signer the Default Program for Opening PDF Documents

Procedure to Make pDoc Signer the Default Program for Opening PDF Documents in Windows XP*

1. Right click on a PDF document icon. A window will open with a menu.
2. Hover the mouse over the Open With option. A window will open with a list of programs.

3. Left click on the Choose Program... option at the bottom of the list. An Open With Window
will open.

4. Left click on the Browse... button. An Open With... window will open.
5. Navigate to the pDoc Signer folder, and double left click on it to display the folder contents.

6. Left click on pDoc Signer.exe. It will be highlighted and the entry pDoc Signer.exe will
appear in the File name box.

7. Left click on the Open button. The Open With... window will disappear, and the Open With
window will show pDoc Signer highlighted.

8. Left click in the check box Always use the selected program to open this kind of file.

9. Left click on the OK button. The Open With window will disappear, and pDoc Signer will
open displaying the document selected in step 1. After this, when you double click on a
PDF document icon, pDoc Signer will open and display the document.

Procedure to Make pDoc Signer the Default Program for Opening PDF Documents in Windows 8.1 on
Desktop PCs*

1. Right click on a PDF document icon. A window will open with a menu.

2. Hover the mouse over the Open With option. A window will open with a list of programs.

3. Left click on the Choose Default Program... option at the bottom of the list. An Open With
Window will open.

a) Left click "More Options"

b) Left click "Look for another app for this PC"

c) Left click C:\ drive or local disk

d) Double left click Program Files or Program Files (x86)
e) Double left click pDoc Signer

f) Left click pDoc Signer.exe

g) Left click Open

4. The Open With window will disappear, and pDoc Signer will open displaying the document
selected in step 1. After this, when you double click on a PDF document icon, pDoc Signer
will open and display the document.

*Note: The procedures for other Microsoft operating systems are similar, but may have
variations from these steps.

43 www.topazsystems.com



pDoc Signer User Manual
SYSTEMS INC,

4.3 — Pen Display Installation and Calibration

Installation — To install a pen display, you typically have to download two software packages:
1. The manufacturer’s pen display driver

2. The appropriate DisplayLink driver (DisplayLink USB Graphics Software for Windows) from
this page: http://www.displaylink.com/downloads/downloads.php

Use the Display program in the control panel to configure the pen display for your installation.
You may specify the following characteristics:

1. Resolution, typically the resolution recommended by the manufacturer

2. Orientation, landscape or portrait

3. Multiple displays, typically Extend these displays

4. Alignment, make sure that the bottoms of both the monitors are aligned as shown below

You may use the Tablet program in the Control Panel to complete the installation. For
example, you may specify 90 degree rotation for the pen display to operate in portrait mode,
see the screenshot below. If you make changes, click on the Save icon on the left side of the
window.

Calibration — If you are not able properly scribble using the pen attached to the Pen Display or
if the scribbling does not appear at the place where you intend to sign, you might have to
calibrate the Pen Display device. To calibrate, follow the steps below.

1. Right click on your desktop on the main monitor and then select “Screen resolution” or
navigate to the screen using the Display program in the Control Panel.

2. In the displayed window, make sure that the bottoms of both the monitors are aligned as
shown below.
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Change the appearance of your displays

Display: 1.Mobile PC Display v |
Resaolution: | 1366 = 768 (Recommended) V|
Orientation: | Landscape w |
Multiple displays: |E:-rter1d these displays V|
This is currently your main display. Advanced settings
Project to a second screen (or press the Windows loge key Bm + P)
Make text and other iterns larger or smaller
What display settings should | choose?
| Ok | | Cancel | Apply
3. Now, navigate to Control Panel and then open the item “Tablet”. In the displayed

window, select “Mapping” in the list of options available on the left hand side. See the
screenshot below.
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‘PenSeﬂing
Voo
) v

Q About

IIIIIIIIIEH

e

TabletlD: {8534  ~| | & Select Monitor [ponitor 2 |

" Part of Monitor

Rotate: Twist_norn -

=

{_'  Auto Setting ¢ AllTablet 2z Calibrate

4. Click on the option “Calibrate” and then follow the instructions displayed on the “Pen
Display” device. Once completed, click on the “Save” button in the above screen and
then close the “Tablet” application.

You can use the “Pen Display” device for signature capture.
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